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1 Introduction

1.1 Scope of this document

The document explains the necessary steps an astronomer has to perform to define an area on the
sky that shall be covered by observations with the ESO Survey Telescopes (VISTA and VST). It is
written in a linear fashion and is supposed to be followed step by step, i.e. section by section.

1.2 Contents of this document

The document contains only the basic knowledge on SADT needed to define a survey. This version
of the Cookbook is tailored for observations with VISTA only. It describes the main functionalities
of the tool, but does not describe the installation of the tool (see the SADT web page for that)
nor the use of its output files for the further phase 2 preparation with P2PP for Public Surveys.
For those actions please consult the following web pages:

http://www.eso.org/sci/observing/phase2 /VIRCAM /SADT .html
http://www.eso.org/sci/observing/phase2/P2PP /P2PPSurveys.html

1.3 Contact information

In case of specific questions related to SADT and its use together with P2PP for Public Surveys
please contact the ESO User Support Department via this email address:

usd-help@eso.org

1.4 Acknowledgements

This Cookbook is mainly based on the document ‘Survey Area Definition Tool: User Manual for
VISTA' (issue 2.0) by Jim Emerson, the VISTA Data Flow System project leader. This manual can
be downloaded from the web page of the VISTA consortium:

http://www.vista.ac.uk/observing/sadt/

1.5 Abbreviations and Acronyms

a0 active Optics (to differentiate it from AO=Adaptive Optics)
ESO European Southern Observatory

GUI Graphical User Interface

OB Observing Block

P2PP Phase Il Proposal Preparation

PLASTIC Platform for Astronomical Tool Interconnection
SADT Survey Area Definition Tool

uUsD User Support Department

VLT Very Large Telescope

VISTA Visible and Infrared Survey Telescope for Astronomy
VST VLT Survey Telescope
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2 Read this first: The SADT concept and limitations

2.1 What does SADT do?

SADT is a software that, in the end, produces a file that you must import into P2PP for Public
Surveys to generate the observation blocks (OBs) of your survey. That file, called XML Survey
Definition file (or just XML file in the following), contains a list of all pointing positions for each
tile and its pawprints within a survey. In addition it contains the positions of suitable guide and
wave front sensor (or active optics (a0)) stars for each pawprint that are necessary to observe each
survey tile under optimal telescope performance. SADT searches for these guide and aO stars using
public star catalogs from the web. It iteratively adjusts the tile positions if insufficient guide/aO
stars were found. Thus, SADT is an auxiliary, but also mandatory tool that facilitates the
creation of the numerous OBs of a survey together with P2PP. SADT is not concerned about what
observations are carried out at each position in a survey (except some input parameters regarding
the tile and jitter pattern, see Sects. 3 and 4).

Creating one or several XML files is your goal. Before you start with SADT, you need to have
a clear idea about your survey layout (boundaries, overlap) and observing strategy (tile pattern,
jittering, etc., see Sect. 3.1). How to get from these input parameters to your desired output
product is all explained step by step in this Cookbook.

2.2 Some important limitations of the tool

So far, SADT is only applicable to observations with the ESO survey telescope VISTA. No obser-
vations with VST or the VLT instruments can be prepared with this tool.

SADT supports the definition of areas using coordinate ranges or geodesic rectangles/circles in
different coordinate systems, like FK5 (J2000), Galactic or Ecliptic coordinates. However, not all
kinds of coordinate definitions are appropriate for all areas on the sky, i.e. one should use geodesic
rectangles and not coordinate ranges for areas with declinations/latitudes above 60 deg and below
—60 deg. Trying to define areas with coordinate ranges close to the poles of a coordinate system
results in a wrong, though sometimes funny, graphical representations of the tiles. Even when
using geodesic rectangles and choosing the plot type ‘South Polar Plot’ some tiles that cover the
polar region might not be correctly represented in the display window. Still the tile and pawprint
coordinates in the output file are correct.

The tiles within one survey area definition will all have the same orientation. If more than one
orientation is needed within a survey the total survey area has to be split up into several independent
area definitions.

The allocation of tiles in a survey area will always start in the South-West (lower right) corner of
each survey area. It is not possible to choose another starting point of the tile allocation.

The SADT display does not show the location of any targets, like bright stars or extended galaxies.
If one wants to avoid bright stars one either can define some sub-areas that shall be excluded from
a survey area (see Sect. 5.2) or one can delete individual tiles after the definition of all tiles in a
survey area (see Sect. 6.3). There exists the possibility to plot tiles (or overlay them on sky images)
in Aladin or other VO tools communicating via a ‘PLASTIC', hub (see Appendix B).
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3 Step 0: Getting ready — define your survey layout and
observing strategy

This step describes the preparations done outside SADT. Having all the following parameters and
information in hand is an important prerequisite to successfully run SADT.

3.1 What you need

This Cookbook assumes that your are familiar with the instrument that you are using for the survey
observations. In particular, you should know the CCD layout of the camera, i.e. the pawprint, and
the total size of the tile you want to use to uniformly cover an area. A tile is a filled and fully
sampled area of sky formed by combining multiple pawprints. Because of the detector spacing,
the minimum number of pointed observations (with fixed offsets) required for reasonably uniform
coverage is 6, which exposes each piece of sky, away from the edges of the tile, to at least 2 camera
pixels. All this information can be found in the VIRCAM/VISTA User Manual (in particular, Fig. 5
and Table 15), which can be downloaded from this web page:

http://www.eso.org/sci/facilities/paranal /instruments /vista/doc/
In the following the parameters that are relevant to SADT are summarized:

e Borders of your survey or survey areas: this can either be a coordinate range in right
ascension /declination (in the FK5 (J2000) or FK4 (B1950) system) or longitude/latitude (in
the Galactic, SLOAN or ecliptic system), or it can be a geodesic rectangle or circle with a
central coordinate (in either of the coordinate systems mentioned before) and a width/height
or radius in degrees.

e Position Angle of your survey area: in case your survey area shall be tilted with respect
to a specific coordinate system you should be prepared to provide a position angle (with the
usual counter-clockwise convention North = 0 degrees, East = 90 degrees).

e Orientation of the tiles: The orientation of the Y-axis of the tiles with respect to the
survey area can be chosen in steps of 90 degrees: 0, 90, 180 and 270 degrees. Note that
within a survey area definition the tile orientation cannot be changed.

e Overlap of adjacent tiles: depending on your observing strategy you might want to change
the default overlap of 60 arcsecs in X and Y to another value. SADT computes the position
of the adjacent tiles taking the desired overlaps into account.

e Tile pattern: to fully cover an area by VIRCAM pawprints, six pre-defined offsets are
necessary. Different offset patterns are described in the template description of the VIR-
CAM/VISTA User Manual (see Fig. 19). The tile pattern has to be predefined in SADT and
will be automatically transfered to the OBs (no later change possible).

e Maximum jitter amplitude: during the preparation of the OBs different jitter patterns
with different maximum amplitudes and microsteps can be chosen (see VIRCAM/VISTA
User Manual, see Fig. 20 and Table 18). SADT has to know the maximum jitter4+microstep
amplitude (+/-, i.e. from 0 to max or min) in order to reduce the search area for suitable
guide and a0 stars accordingly (such that none of the stars falls outside the autoguider and
wave front sensor CCDs).
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3.2 The Guide/a0 star input catalog

SADT needs star catalogs in order to search for guide and active optic stars. Three catalogs are
selectable from a pull-down menu within SADT. Those are GSC-2, USNO and 2MASS. In most
cases the GSC-2 should suffice and is highly recommended, but certain areas on the sky might
be better covered by another catalog. Please make sure which catalog is most appropriate for
your survey area. And, of course, you need an enabled network connection to access the external
catalogs.

3.3 Splitting the survey into survey areas

If you belong to the happy astronomers that got approved an ESO Public Survey that lasts over
several years, you probably have a large area to cover (or a very deep field). In principle, you
can define the whole survey area at once with SADT. Practically, your survey observations will be
scheduled in semesters/periods, i.e. your are not allowed to submit all OBs of the full survey at
once but will have to create OBs for a limiting total execution time per semester. Thus, a natural
split of your total survey would be into individual survey areas that shall be covered in a certain
observing period. Of course, the chosen areas should be observable in that semester.

Another reason for splitting the total survey into individual survey area definitions might be a
different observing strategy in different regions, for example different filter sets, different exposure
times, different jitter patterns, etc.. In this respect, be reminded that SADT is an auxiliary tool to
help you in creating a large number of OBs that share the same structure.
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4 Step 1: Starting SADT and setting some basic parameters

Do you have all the information ready pointed out in Step 0?7 Do you have installed SADT and P2PP
for Public Surveys on your machine? Did you set the correct path to P2PP’s VIRCAM instrument
package (check the SADT installation web page if you do not know what this is about)? If yes,
you are ready to start SADT. To do so go to the bin directory of your SADT installation and type:

> sadt &

and you should see the following window pop-up (here under KDE/Linux):

Survey Area Definition Tool (VISTA)

File Options Help

survey ID [vista_survey |

Survey Areas |

Type | Raflong) | Dec(laty | Width (Long 2) | Height (Lat 2) | Angle | System  |Exclude

Add Survey Area H Delete Survey Area
Tile Patterns
VIRCAM_Tile6n ‘ -
Catalogs
GSC-2 at ES0 -
View / Updat... ” Start / Resume ” Stop ” Reset H Plastic ‘

This is the main SADT window, or SADT GUI (Graphical User Interface).

The first thing you can do is to give your survey area a name. In the present example we typed
into the 'Survey ID’ field on the upper left ‘vista_survey' (case A in the following). The output
XML file will then get the name ‘vista_survey.xml'.

Note: The ‘Survey ID" will also form part of the name of the OBs and parameter files created for
your survey by SADT /P2PP, so use something brief but clear.

Next some basic parameters have to be set.
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4.1 Configuration preferences

From the pull-down menu ‘Options’,

Find Cuide /a0 Stars
Fixed Aspect Ratio

| —
v Draw Pawprints
J Draw Aux Detectors L

Surve)

P |nclude Overlap gedtay
Configure...
select the task ‘Configure.... You will see popping up the following ‘Configuration preferences’

window:

X Configuration preferences
Amaunt by which adjacent tiles should owerlap (arcseconds):

==2x sampled overlap in X |60.0 ==2% sampled overlap in ¥ |60.0

Maximum jitter amplitude + /- {i.e. O to maxfmin) which will be used in the survey (arcseconds):

Maximum Jitter Amplitude: [15.0 |

Tile ¥ axis arientation (degrees):

Tile Orientation: |0 ‘v|

Backtrack step if not enough guidefad stars found {arcseconds):

Backtrack Step: [100.0 |

| Ok || Apply H Cancel ‘

e First, you can define the desired overlap in X and Y of the adjacent tiles. The overlap
size is given in arcsecs. Note that for most pawprint patterns, in particular the default Tile6
patterns, there exists an upper and lower horizontal strip of about 330 arcsec width that is
covered only once by a pawprint, thus these strips are singly exposed (see Fig. 14 of the
VIRCAM/VISTA User Manual). Since it is assumed that all the survey area shall be covered
by at least two pawprints (doubly exposed), the definition of the Y overlap excludes the 330
arcsec wide horizontal strips on the top and bottom of the tile. In other words, the following
overlaps in X and Y should be applied for different situations:

— overlap X = 0, overlap Y = 0: adjacent tiles do not overlap in X, they just butt,
but they overlap in Y by 330 arcsec. This ensures that the whole survey area, except
at the upper/lower edges, is covered by two exposures at least (= doubly exposed).

— overlap X = 0, overlap Y = -330: adjacent tiles just butt in X and Y, there is no
overlap of tiles. This means that there will 660 arcsec wide strips within the survey
area that are only singly exposed (covered by only one exposure). This option is not
recommended.

— overlap X > 0, overlap Y > 0: adjacent tiles will overlap in X and Y by this amount.
All overlapping areas are 2x doubly exposed, thus covered by four exposures at least.



SADT Cookbook Issue 1.0 7

— overlap X = 60, overlap Y = 60: doubly exposed areas of adjacent tiles will overlap
in X and Y by 60 arcsec. These default values are recommended for ease of tying
together adjacent tiles during data processing.

e Second, you should define the Maximum Jitter Amplitude including microsteps to be
used in the OBs. It is defined as the largest modulus of all the offset values (in arcsecs) of a
jitter pattern and then rounding up. The selectable jitter patterns and their offset values are
given in the VIRCAM/VISTA User Manual (see Fig. 20 and Table 18). Note that the jitter
offset may be scaled by the multiplicative factor ‘Jitter scale value’ in the OB definition, so
‘Maximum size of jitter’ would need to be multiplied by ‘Jitter scale value' if a value other
than the default of 1.0 is used. A maximum jitter amplitude of 15 arcsec (the default value)
is large enough to accommodate all pre-defined jitter patterns with ‘Jitter scale value = 1'.

Important note: If the maximum jitter amplitude is set larger than necessary the area over
which guide/aO stars will be sought will be smaller than necessary, which could be a problem
especially in regions of low star surface density.

If the maximum jitter amplitude is set smaller than the actual maximum jitter amplitude used
in the OBs some guide/a0O stars may fall off the CCD during a jitter, causing the failure of
the OB execution. This has to be avoided.

Thus, the maximum jitter amplitudes set in SADT MUST not be smaller than those values
implicitly chosen for the OBs created in P2PP (by choice of ‘Name of Jitter pattern’ and
‘Jitter Scale Multiplier’).

e Next, the Tile Orientation can be chosen from a pull-down menu to be 0, 90, 180 or 270
degrees. This rotates the tiles with respect to the position angle of a given survey area. The
angle is defined counter-clockwise, with the positive Y-axis of the CCD array (which is the
short axis of the rectangular tile) being at 0 degrees.

Because VISTA tiles are rectangular, not square, a more efficient tiling of a small survey area
(fewer tiles to cover it) can result from choosing an appropriate tile orientation.

e Finally, the Backtrack Step defines the amount in arcsecs by which the SADT's guide/a0
star search algorithm shifts a tile back along the row of tiles. The backtrack step is repeated
until guide/a0 stars are found or the previous tile position is reached. Note that backtracking
has the following effects: 1) more tiles may be needed than are found with the ‘Find guide/aO
Stars’ selection set to ‘Off’ in the ‘Options’ menu; 2) the X boundaries of tiles in adjacent
rows will not match up; and 3) the tile centres at the end of the process will differ from those
at the start.

Confirm all your settings by clicking the 'OK’ button.

Important note: SADT does not remember the last values used when it was last shutdown so
these options will need to be set each time SADT is started up.
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4.2 Further basic settings

In the main SADT window you have two pull-down menus in the lower half, one to set the tile
pattern, the other to choose a catalog.

Tile Patterns

| VIRCAM_Tileén e
VIRCAM_Tile3px |
VIRCAM_Tile6s
VIRCAM_Tilebss
VIRCAM_Tile6u
VIRCAM_Tile6z
VIRCAM_Tilebzz
VIRCAM_TileXTalk v

e

Tile Patterns: In this pull-down menu you have to define the tile pattern you want to use for
your observations. This tile pattern will automatically be transfered to the OBs. It must not
be changed in P2PP later! The different tile patterns, their acronyms and their sequences of
offsets are explained in detail in the VIRCAM/VISTA User Manual (see Fig. 19). Note that the tile
pattern ‘VIRCAM _Tilel1_00" corresponds to the ‘Single' tile pattern in P2PP (i.e. taking a single
pawprint).

2ZMASS Catalog at CD5

GSC-2 at 5TScl .
Guide Star Catalog at CADC

Guide Star Catalog at ESO

USNO B1.0 Catalog at CDS

USNO at CADC
USNO at ESO

Catalogs: The second pull-down menu allows you to choose the catalog that shall be used by
SADT to search for appropriate guide and aO stars.

Note that the guide/aO star CCDs are filtered for | band (0.60-0.87 micron) and so use of
catalogs that do not provide equivalent magnitudes should be avoided. For example, although the
range of catalogs avialable in SADT offers the possibility to find guide/aO stars using 2MASS do
not do so! VISTA commissioning work has been done using GSC-2 at ESO which is believed to
be the most appropriate catalog for finding VISTA guide/aO stars.

If more appropriate catalogs will become available in the future there exists the possibility to include
these in the configuration files. This is explained In Appendix B.
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5 Step 2: Defining the survey area — coordinate systems
and display options

This step helps you to get used to the different possibilities of defining a survey area and to view it
in different coordinate systems. Experienced SADT users might just want to enter their coordinates
and jump to step 3.

In the main SADT GUI click the button ‘Add Survey Area’. A line with different columns will
appear under the ‘Survey Areas’ folder. From the pull-down menu in the ‘Type' column, first select
the area type you want to use:

Type Ra 1
¥ Coordinate Range  00.
Circle

GCeodesic Rectangle

e ‘Coordinate Range’ (default) allows you to enter the lower and upper bounds of the
chosen coordinate system (see below). No rotation angle of your survey area can be entered
when choosing this type.

e For the option 'Circle’ enter the central coordinate of the area and a diameter in degrees.
Although it is allowed to enter an angle this has no effect on the orientation of the tiles, thus
this parameter can be neglected.

e A ‘Geodesic Rectangle’ is defined by its geometric centre and a width and height in
degrees. Here the definition of an angle makes sense. It will rotate the defined rectangle
around the central position. The sense of rotation is counter-clockwise with respect to the
chosen coordinate system. This area type should be your preferred choice if your survey
area covers regions with declinations/latitudes above 60 deg and below —60 deg.

The descriptions in the column headers running rightwards from ‘Type' change according to the
‘Type' in the row selected for that ‘Type'.

Note: Because using coordinate ranges inevitably produces different shaped areas at different de-
clinations/latitudes, and because SADT aligns the bottoms of coordinate range tiles along lines of
constant Dec/Latitude (or at an angle relative to Dec/Latitude) there will inevitably be significant
problems in automatically covering areas completely when the areas have been defined as coordi-
nate ranges especially at high Dec/Latitude. Therefore, and given that the VISTA field of view is
itself rectangular on the sky, it is recommended that geodetic rectangles are used as the
most reliable way to cover areas of the sky fully and efficiently. For example, to tile the
whole Southern hemisphere requires 13.029 tiles in ‘Geodetic Rectangle’ mode, and 13.235 tiles in
‘Coordinate Range’ mode which actually fails to cover the South pole region completely.
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The next parameter you want to define is the coordinate system in which your area will be defined.
From the pull-down menu in the ‘System’ column you can select one of these options:

20 | System Exclude
0]y FK5 (2000)
Flc4 (E1950)
GCalactic
SLOAMN
Ecliptic

FK5 (J2000) (default): requires input in RA and Dec.
FK4 (B1950): requires input in RA and Dec.

Galactic: requires input of Longitude and Latitude.

[SLOAN]: requires input of Longitude and Latitude. Note that this mode is not supported
for VISTA and has not been tested, and thus may not work.

e Ecliptic: requires input of Longitude and Latitude.

The descriptions in the column headers running rightwards from ‘Type’ change according to the
‘System’ in the row selected for that ‘Type'.

In most cases, either the ‘FK5 (J2000)" or the ‘Galactic’ system should suffice.

The entry fields for all coordinate and size related parameters (RA, Dec, Lon, Lat, Width, Height,
Diameter and Angle) can be activated by a fast double click with the left mouse button. Just
overwrite the default values or move with your arrow keys or left mouse button to the digit you
want to edit/change. The value input is only saved when the cell is closed. Press carriage return
to close the cell, or single click elsewhere to achieve the same effect. Here are some important
conventions you should be aware of:

e For RA and Dec coordinates use the format “HH:MM:SS.SS" or “HH MM S.SS". For
Longitude and Latitude definitions use decimal degrees (not decimal hours).

e The (position) angle (in degrees) on the sky is the angle between North in the selected
coordinate system and the ‘Height' axis of the survey area. It has the usual convention:
North=0 deg, East=90 deg. SADT applies the ‘Angle’ and ‘Tile orientation’ to derive
the ‘offangle’ in the output XML file that must be sent to the Telescope Control System
(TCS) in an OB. Note that ‘offangle’ correctly obeys the ESO TCS convention and is not a
conventional (net) astronomical position angle.

e Regardless of the input coordinate system used, the tiles in the output XML files are specified
in RA, Dec (J2000) for use at the telescope.

The survey area that you want to save in the end does not have to be restricted to one definition
of a coordinate range or geodesic rectangle. You can add as many areas as you like. Just click the
‘Add Survey Area’ button again and a second line will appear. You even can exclude sub-areas from
a larger area or from further processing in SADT by clicking the checkbox of the ‘Exclude’ field,
the rightmost item in the column headers. If you are not happy with one of your area definitions
you can delete this area by clicking on the ‘Delete Survey Area’ button and confirming the deletion.
After deleting an area click on ‘View / Update Areas’ to refresh the display.
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In the following figure we show an overview on the different ways of defining a survey areas, either
by coordinate ranges (diagrams a & c) or geodesic rectangles (diagrams b & d). In all four diagrams
the darker blue lines represent a fixed coordinate system (e.g., RA/Longitude, Dec/Latitude). The
lighter blue lines in ¢ & d represent the rotated coordinate system in which the survey area was
defined.

Diagram (a) shows a (green) coordinate range painted on a spherical coordinate system with a
red dot marking the centre, diagram (c) shows a (green) coordinate range defined in a different
(rotated) spherical coordinate system painted on the different (light blue rotated) spherical coordi-
nate system with a red dot marking the centre. The dark blue grid represents RA/Dec. The yellow
angle shows the (position) angle from the RA/Dec frame to the new frame and is used internally
in SADT.

Panel (b) shows a (green) geodesic rectangle with position angle zero projected on a fixed spherical
coordinate system (dark and light blue grid) with a red dot marking the centre, panel (d) shows a
(green) geodesic rectangle defined in a different (rotated - light blue) spherical coordinate system,
and projected on the fixed spherical coordinate system (as in b) with a red dot marking the centre.
The dark blue grid generally represents RA /Dec. The yellow angle shows the (position) angle when
looking out from the inside of the fixed system.

In the next two subsections, we give two examples of survey area definitions and describe the
different viewing options.
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5.1 Case A: defining and displaying a non-contiguous area

Under the name ‘vista_survey’ we defined four sub-areas using different areas types and different
coordinate systems. Our definitions look like this:

File Options Help
Survey ID [ista_survey |
Survey Areas |
Twpe Lon Lat Diameter {deg) - Angle ideq) SsTEm Exrl_de
Coordinate Range  |20.0 -2.0 250 2.0 0|Galactic L]
Coordinate Range |15 10:00 020000 1530000 +02: 0000 OFES §2 0000 L]
Geodesic Rectangle |149:20:00 =07 0000 5.0 4.0 =2 0|FES (2000 ]
Circle 26.0 -2.5 4.5 -— 0|Calactic []
Add Survey Area | Delete Survey Area
Tile Patterns
VIRCAM_Tile6n v
|[Catalogs
GSC-2 at SO -
Yiew [ Update ... || Start / Resume ” Stop ” Reset ” Plastic |

To have a quick look on the layout of these area definitions first make sure that the checkboxes in
the ‘Options’ menu (at the top of the main window) are correctly set. When clicking the ‘Options’
button you get the following list of checkboxes:

Help

Find Guide /a0 Stars
v Fixed Aspect Ratio
v Draw Pawprints

Draw Aux Detectors
v Include Overlap

Configure...

e Find Guide/aO Stars: if you don't want to perform a (time-consuming) guide/aO star
search in your first attempt to define a survey area and see the tiling, leave this box unchecked
(the default when starting SADT). Check this box only if you think that the survey area
definitions are finalized.

e Fixed Aspect Ratio: by default this box is unchecked. You might want to check this box if
you want to see your survey area on the same scale in the X and Y coordinate. If not checked
the smaller side of your area will be scaled such that the display window is homogeneously
filled.

e Draw Pawprints: by default this box is checked. If you want to see only the tile borders
(without pawprints) you can uncheck this box. Still the pawprint centres are shown as dots.
For very large survey areas this might be the preferred option.

e Draw Aux Detectors: by default this box is unchecked. If you want to see the location of
the auxiliary detectors for guiding and wave front sensing you can tick this box. This option
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only works if the ‘Draw Pawprints' box also is checked. The autoguider CCD on top of the
positive Y axis of the detector array is painted in black. This allows a clear identification of
the pawprint orientation (see example in Sect. 5.3).

e Include Overlap: this option only is interesting if your total area definition contains sub-
areas that are excluded (see our Case B, Sect. 5.2). Tiles which lie partially in an included
survey area and partially in an excluded survey area are included (box checked). Otherwise
they are excluded (box unchecked). By default this box is checked.

e Configure ...: the configuration preferences already were explained in Sect. 4.1.

Now it's time to display our area definitions. We chose the ‘Fixed Aspect Ratio' option ticked.
By clicking the button 'View / Update Areas’ on the lower left in the main SADT window the
following ‘Survey Areas’ window will pop up:

Survey Areas (displayed in FK5 (J2000), Cartesian Plot, Zoom: 1)
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In the header of this window you see the actual ‘Display Coordinate System’, ‘Plot Type' and
‘Zoom' option. How to change these display options is explained in Sect. 5.3.

As seen, pressing the 'View / Update Areas’ button allows viewing of survey areas specified in the
text box without starting generation of pawprints and allocating the guide/aO stars (even if the
‘Find Guide/aO Stars’ checkbox is ticked.

Also use ‘View / Update Areas’ after making a change to the survey areas defined in the ‘Survey
Areas’ table.
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5.2 Case B: defining and displaying an area with exclusions

Our second case, which we call ‘eso_survey', consists of three independent geodesic rectangles
and five rectangle sub-areas that were excluded from those three main areas. For excluding the
sub-areas, the corresponding checkboxes in the ‘Exclude’ column were ticked. All coordinates were
defined in the FK5 (J2000) coordinate system. The survey area definitions look like this:

i a L 0 00 i [
File 0Options Help
Survey ID [es0_survey |
Survey Areas |
Twioe Fi, Dec Wicith (dleq) | Height (ded) |Angle (ceq)| System | Exclu cle|
Ceodesic Rectangle |02:20:00 —20:00:00 4.2 10.0 OFES (2 000y | |
Ceodesic Rectangle |02:15:50 -28: 0000 2.5 2.0 OFES (2000)  [v]
Geodesic Rectangle[02:15:50  |-32:00:00 2.5 2.0 O[FKS (J2o00|  [v]
Geodesic Rectangle |01:55:00 -20:00:00 4.2 100 OFKS (|2 000) [ ]
Geodesic Rectangle [01:51:00  |-28:00:00 2.5 2.0 O[FKS (2000 | [l
Geodesic Rectangle [01:59:00  |-22:00:00 2.5 2.0 O[FKS (2000 | [l
Ceodesic Rectangle (0120000 2000000 4.2 10.0 OFES (2000 [ ]
Ceodesic Rectangle (0120000 -20000:00 1.8 &0 OFES {(2000)  |[v]
Add Survey Area || Delete Survey Area
Tile Patterns
VIRCAM_Tile6n e
Catalogs
GSC-2 at ES0 e
View / Updat. | Start/ Resume | Stop I Reset I Plastic |

Clicking the ‘View / Update Areas’ button and having the ‘Fixed Aspect Ratio' box in the ‘Options’
menu ticked gives the following result in the display window:

Survey Areas (displayed in FK5 (J2000), Cartesian Plot, Zoom: 1)

-20:00:00

-25:00:00

-30:00:00

-35:00:00

-40:00:00

02:40:00 02:20:00 02:00:00 014000 01:20:00

Surprise, surprise! What a nice survey area!
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5.3 Display options

The display window offers different options to change the display coordinate system and plot type
and to get positional information. All these options are triggered by cursor commands.

Keeping the middle mouse button pressed on the display window will pop-up a line below the
display window which shows the coordinates at the cursor position in the current coordinate system.
To get information on another cursor position you have to release the middle mouse button first
and then move to the desired position pressing the middle button again.

A click on the right mouse button on the display window (except in a selected, cyan tile) will
pop-up a menu with the following options:

Zoom In
Zoom Out
Reset Zoom

= Display Coordinate System: +

FK5 (J2000)
FK4 (B1950)
Galactic
7 Ecliptic 7
SLOAN

Cartesian Plot
North Polar Plot
South Polar Plot

e Zoom: the number indicates the actual zoom factor (1 is the default). You can either tick
the checkbox ‘Zoom In' or the checkbox ‘Zoom Out’ which will directly bring you back to
the display window. A click with the left mouse button will perform a ‘zoom in’ or ‘zoom
out’, centred on the cursor position. To get back to the default display for your survey area
choose the ‘Reset Zoom' option in the ‘Zoom’ menu.

e Display Coordinate System: here you can choose the coordinate system in which you
want to have displayed your survey area. The options are the same as in the SADT main
GUI (see Sect. 5). The default is the ‘FK5 (J2000)" coordinate system. Note that the choice
of a coordinate system only affects the displayed plots. It is not converting the coordinates
displayed in the ‘Survey Areas’ table between systems. In most cases, you probably want to
use for displaying the same coordinate system you used for the coordinate definition in the
main GUI.

e Plot Type: The default is ‘Cartesian Plot’. But you also can choose a ‘North Polar Plot’
or ‘South Polar Plot’, both with respect to the chosen ‘Display Coordinate System’. Those
representations are very useful if your areas are close to one of the poles. Needless to say
that the plot type ‘North Polar Plot’" makes no sense if your area is defined at negative
declinations/latitudes.
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To illustrate the effect of changing the coordinate system, the area ‘eso_survey' as defined in
Sect. 5.2 (Case B) is shown here in Galactic coordinates (with ‘Fixed Aspect Ratio’ unticked and
as Cartesian Plot):

Survey Areas (displayed in Galactic, Cartesian Plot, Zoom: 1)
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-77.500

-80.000

-82.500
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-87.500
280000 270000 260000 250000 240000 230000 220000 210000 200000 130000 @ 180.000

And just for fun, the same area in ‘Galactic’ coordinates as ‘South Polar Plot’' , the ‘Fixed Aspect
Ratio’ ticked and zoomed once out (factor 1/2):

0,000 70,000

000 03T

Note that this area is located close to the Galactic South Pole, a region that has a low density of
foreground stars, and thus affects the search for suitable guide/aO stars (see Sect. 7.2).
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As a last example we show here the ‘vista_survey' area (Case A) zoomed in by a factor 4 and with
the checkbox ‘Draw Aux Detectors’ in the ‘Options’ menu ticked. This was done after Step 3 was
performed (see Sect. 6.1).

-03:00:00

-~04:00:00 %'\

AL

-05:00:00

-06:00:00
/

-07:00:00 \

19:00:00 18:56:00 18:52:00 18:48:00 18:44:00 18:40:00

As explained in Sect. 5.1 the black, solid rectangles show the positions of the autoguider CCDs
above the detector array (positive Y axis, see Fig. 5 in the VIRCAM/VISTA User Manual).

An important note on the interpretation of shapes displayed:

SADT's default display is simple Cartesian, not a spherical projection. Shapes of areas plotted must
be interpreted with this in mind. The shapes seen will also depend on the ‘System’, ‘Type', ‘Aspect
Ratio" and values set, and the projection used. Be careful not to jump to incorrect conclusions
about your tiles based on the plots. Some examples are:

e In the Cartesian plot a ‘Geodesic Rectangle’ and a ‘Coordinate Range’ will look similar close
to the equator, however near the pole a range will still look like a rectangle, whereas a
geodesic rectangle will look like a slice.

e In a ‘Cartesian Plot’ a coordinate range defined in a particular coordinate system appears as
a rectangle in the survey area display only if the same coordinate system is selected as display
coordinate system.

e Equivalent (but different) considerations arise when plotting in ‘South Polar’ projections.
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6 Step 3: Tiling the survey area — a first test run and some
tile operations

If you are happy with the definition of your survey areas, you now probably want to see how the
tiles will get distributed across the areas and how many tiles you need to cover them.

Still, at this point we do not intend to search for guide/aO stars which is the most time-consuming
procedure of the SADT session. So please leave the ‘Find Guide/aO Stars’ checkbox in the ‘Options’
menu of the SADT GUI unticked.

Again, we will demonstrate the allocation of tiles to the survey areas for our two examples, Case
A and Case B.

6.1 Case A: Tiling of non-contiguous survey areas

The survey area ‘vista_survey’ was defined in Sect. 5.1 and we had a look at the layout by choosing
the ‘View / Update Areas’ button. Now, click the button ‘Start / Resume' in the lower part of the
SADT GUI and you will see the following in the display window:

Survey Areas (displayed in FK5 (J2000), Cartesian Plot, Zoom: 1)
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Note: The allocation of tiles always starts in the lower right hand corner of the area to be filled
(South-West corner in case of RA/Dec coordinates). First the lower row is filled from right to left,
and then the next row up (higher Dec) is filled from right to left (increasing RA). This is continued
until the area is filled.

At the same time the tiles are shown in the display window there will pop-up two new windows: 1)
the ‘Guide Star Acquisition’ window which is empty at this stage because we unticked the option
of finding guide/a0 stars, and 2) a window called ‘Finished’ which shows a summary of the tile
allocation.
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In our case the ‘Finished’ window looks like this:

X Finished

Mumber of tiles in the survey areasgs): 64

Mumber of pawprints in the survey areas(s)y: 384

Mumber of times backtracking had to be used to find a guide star
after the pointing creation was started or resumed: 0

Mone or too few guide/ a0 stars

Type Mone Found | Too Few Found

LOWFS_PY | 384 tiles 0 tiles

Al 384 tiles 0 tiles

LOWFS_NY | 384 tiles 0 tiles

Please save the results.

As you can see our ‘vista_survey' needs 64 tiles to cover the full area, which implies 384 pawprints
because of the tile pattern ‘"VIRCAM_Tile6bn’. The further information about backtracking during
the guide star search and the corresponding statistics table makes no sense in case the ‘Find
Guide/aO Stars’ option is unticked.

To continue with any other action you have to confirm the tile generation by clicking the ‘OK’
button in the ‘Finished” window.

The allocation of tiles can be stopped, resumed and after finishing reset. For that use the buttons
in the lower row of the SADT main GUI. Their functionalities are summarized here:

e Start / Resume: This begins or resumes the process of filling the defined survey areas
with tiles/pawprints, and — if ‘Find Guide/AO Stars’ option on the ‘Options’ menu is on — it
starts/resumes finding guide/aO stars.

e Stop: This stops the process of making tiles/pawprints and finding guide/aO stars (in
case the checkbox ‘Find Guide/AO Stars’ is ticked). This may be necessary if the internet
connection to the catalog is slow, or the run is taking longer than expected. After hitting
the 'Stop’ button it is possible to save intermediate results to an XML file by choosing the
‘Save As ..." task in the ‘File’ menu (see Sect. 8). This file can later be opened again using
the ‘Open’ task in the ‘File’ menu. The generation of pawprints can then be resumed where
it had stopped before.

e Reset: This resets the plots and deletes any tiles/pawprints made. It does not affect the
surveys defined in the main GUI — just the display. The user is asked to confirm the reset in a
pop-up window. Note that it is sometimes necessary to use ‘Reset’ before finding guide/aO
stars will work (e.g if they have just been toggled on).

Note: Users are advised to be careful to use ‘Stop’ and ‘Resume’ as there have been reports that
some material may sometimes be lost during a Start/Stop/Resume sequence. Check that tiles or
guide/aO stars have not gone missing around the sky position you pressed ‘Stop’ at.
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6.2 Case B: Tiling of areas with excluded sub-areas

Our case B is the ‘eso_survey' (see Sect. 5.2). As for case A, we do not select the ‘Find Guide/aO
Stars' option. We just want to see the proposed tiling by clicking the ‘Start / Resume' button
(with ‘Fixed Aspect Ratio’ ticked):

-20:00:00

-25:00:00

-30:00:00

-35:00:00

-40:00:00

02:40:00 02:20:00 02:00:00 01:40:00 01:20:00

The corresponding ‘Finished” window looks like this:

Mumber of tiles in the survey areasgs): 81
Mumber of pawprints in the survey areas(s). 486

Mumber of times backtracking had to be used to find a guide star
after the pointing creation was started or resumed: 0

Mone or too few guide/a0 stars

Type Mone Found | Too Few Found

LOWFS_PY ||486 tiles 0 tiles

AG 486 tiles 0 tiles
LOWFS_NY |486 tiles 0 tiles

Please save the results.

81 tiles, or 6 x 81 = 486 pawprints, are needed to cover the full ‘ESO’ area. To continue with any
other action confirm the tile generation by clicking the ‘OK’ button.
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Maybe you are not happy with some tiles that only cover a small fraction of the desired area but
are mostly located in the excluded sub-areas. One option to avoid the tiling of excluded areas is
to untick the 'Include Overlap’ checkbox in the ‘Option’ menu. After unchecking the box you will
see a pop-up window telling you to ‘Reset’ and ‘Start’ again the tile allocation for the option to
come into effect.

So, just confirm this pop-up window by clicking the ‘OK’ button, and then press the ‘Reset’ button
in the main SADT window. Another pop-up window assures that you don’t delete the calculated
tiles by accident. So, please confirm by clicking ‘Yes' that you would like to continue with the new
tile calculation. Finally, click the ‘Start / Resume’ button. You will see the following:

Survey Areas (displayed in FK5 (J2000), Cartesian Plot, Zoom: 1)
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Most probably, this also is not what you wanted. In the next section it will be explained how you
can manually delete some selected tiles in the display window.
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6.3 Tile operations in the display window

Once you have created the tiles with the ‘Start / Resume’ button, you have various possibilities to
manipulate the tiles with mouse clicks in the display window:

e Select tiles: Click with the left mouse button on a tile. It will be highlighted by a cyan
colour. The selection of that tile disappears if you click on another tile which will be selected
instead. If you want to select multiple tiles you have two options: 1) Press the left mouse
button down and each tile you touch while moving the mouse will be selected; 2) Keep the
Ctrl-button pressed while selecting further tiles with a mouse click or dragging the mouse
along tiles (for Mac OS X: press the Ctrl-button once when selecting the first tile, then
release the Ctrl-button and select other tiles with the left mouse button; finish the selection
by pressing the Ctrl-button once again).

Note that the selection does not work if the ‘Zoom In" or ‘Zoom Out’ checkbox are ticked.
Also, the selection disappears if you use the display options of the right mouse button, like
zooming or changing the display coordinate system, while tiles are selected.

e Deselect tiles: To deselect all tiles click with the left mouse button outside the survey area,
but within the display window. To deselect an individual tile press the Ctrl-button while
clicking on the tile (for Mac OS X: release the Ctrl-button after deselection of the first tile
and finish the deselection by pressing the Ctrl-button once again).

e Tile operations on selected tiles: Selected tiles can be deleted, restored (with or without
a priority) or have an (internal) 4 step priority. Click with the right mouse button on a
selected tile. A pop-up window with ‘Tile Operations’ will appear:

Tile Operations:

Delete tile
Restore tile

Set tile priority »

— Delete selected tiles: Select ‘Delete Tile' and the tile is removed leaving only the
location of the centre of each pawprint.

— Restore deleted tiles: First, click with the left mouse button on a deleted tile (i.e.
that only shows the centres of the pawprints). Then click with the right mouse button
on that tile and select in the pop-up window ‘Restore Tile’. The pawprint patterns
appear again. You also can restore a tile with a certain priority. To do so choose
‘Restore tile with priority’ in the pop-up window an select a priority in the pull-down
menu.

— Set tile priority: Click the right mouse button on a selected tile. When choosing ‘Set
tile priority’ a pull-down menu with four priority levels from 0 to 3 will appear. Those
levels are colour-coded. The tile borders will be represented in the chosen colour. This
action applies to all tiles that are highlighted in that moment.

Note that the allocated priorities have no affect on the OB priority of that tile. This
information is not transferred to P2PP! Priorities can only be used for displaying
purposes.
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In the following figure we show an example for tile operations. We zoomed on the circle area of
the ‘vista_survey'. The two upper left tiles of that area were deleted, only the central positions of
the pawprints are visible as dots. The two upper right tiles were selected, and thus are highlighted
by a cyan colour. The two tiles with blue borders got the priority 2.

Survey Areas (displayed in FK5 (J2000), Cartesian Plot, Zoom: 2)
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An important note: The tile operations are not saved automatically. For example, deleted tiles
can be recovered by the ‘Restore’ option. In order to save the results of the tile operations (deletions
and priorities) choose ‘Save As ..." in the ‘File’ menu. You might want to give that area definition
a new name, in case you regret some of your deletions at a later stage.
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7 Step 4: The search for guide and a0 stars — the final
tiling procedure

Now the time has come to perform the final run of SADT which includes the search for guide
and a0 stars. Make sure that you selected the appropriate catalog: ‘GSC-2 at ESO’ is the rec-
ommended choice! In the ‘Options’ menu tick the checkbox ‘Find Guide/aO Stars’. Before you
start the tiling click on the ‘Reset’ button in the lower row and confirm the pop-up window ‘Delete
existing tiles/pawprints?’ by clicking on ‘Yes'. The tiles from the dry-run will disappear.

In the following, we again show the tiling process including the search for guide and aO stars for
our two examples, Case A and Case B.

7.1 Case A: a smooth tiling run near the Galactic plane

Having passed through steps 1 to 3 and having pressed the ‘Reset’ button, we see our defined areas
of the ‘vista_survey' in green in the display window.

Press the ‘Start / Resume’ button in the main SADT window. The following ‘Progress’ pop-up
window will appear:

X rrogress mm

Downloading query results ... {0__

Stop

| [Reading File: 27 bytes

You can press the stop button at any time if you are not happy with the tiling process. To resume
the guide/aO star search press the ‘Start / Resume’ button in the main SADT window again. Note
that the ‘Stop’ button in the main SADT GUI is disabled during the guide/aO star search.

Apart from the ‘Progress’ window, the ‘Guide Star Acquisition’ window now is active and shows the
search of guide/aO star in each detector. The borders of the detectors are given as black rectangles
for the Autoguider CCDs and black squares for the active Optics CCDs. The header of the window
indicates the name of the actual CCD (see VIRCAM/VISTA User Manual) and its coordinates in
RA/Dec. The different colours for the catalog stars and the background of the window have the
following meaning:

e Colour of stars:

— cyan: Star is in the detector range and has the right magnitude range, it is valid.

— yellow: Star is in the detector range but is invalid because of wrong magnitude range.
— blue: Star is valid, but not in the detector range.

— magenta: Star is not in the detector range and not in the valid magnitude range.

— green: Stars that finally are selected as guide/aO stars. These are only shown if suitable
stars on all guide/aO detectors have been found.
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e Background colour:

— grey: Normal mode of operation, no backtracking needed.
— red: No guide/aO star found yet, backtracking.
— pink: Backtracking was successful.

— red and yellow flash: No guide/aO star was found. The backtracking was unsuccess-
ful. This pawprint is left empty.

Note: when pressing the ‘Stop’ button in the ‘Progress’ window its background colour might be
red, although backtracking is not really executed. Similarly, the detector display might sometimes
stay red even though backtracking has already finished.

This figure shows an example for the search of guide stars for the ‘vista_survey' area:

Detector AG_PY at 18:48:32.105, -00:46:40.37

Three suitable guide stars were found for this autoguider CCD. The one that will be selected will
be coloured green in the next instance.

Note: The autoguider and wavefront sensor detectors will (if you don't have a slow connection
to the catalog) flash by very fast so it will usually be too quick to see much. A log of difficulties
encountered (i.e. information about backtracking) is output in the terminal window from which
you started SADT.
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The progress of the tiling is also shown in the display window. In the following figure we show
a snapshot of the moment when 10 tiles already have successfully be assigned to the upper right
survey area. The three pink pawprints are provisional until guide/aO stars for all the pawprints in
the tile have been found. Then the pawprints become permanent and are displayed in black.

Survey Areas (displayed in FK5 (J2000), Cartesian Plot, Zoom: 1)
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After the search for guide/aO stars has finished the tiling of our 'vista_survey' looks like this:

Survey Areas (displayed in FK5 (J2000), Cartesian Plot, Zoom: 1)

+05:00.00

+02:30:00

+00:00:00

-02:20:00

-05:00:00

-07:30:00

-10:00:00

-12:30:00 I
19:50.00 15:40:00 19:30:00 19020000 19:10:00 19:00:00 18:50:00 184000 18:20:00

There is hardly any difference to the tiling of our dry-run (see Sect. 6.1), since for all pawprints
except one suitable guide/aO stars were found without the need of backtracking.
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This is confirmed in the ‘Finished’ window where the statistics of pawprints, tiles and backtracking

are given:

Number of tiles in the survey areas(s)y: 64
Mumber of pawprints in the survey areas(s): 384

Mumber of times backtracking had to be used to find a guide star
after the pointing creation was started or resumed: 1

Mone or too few guide/ a0 stars

Type Mone Found | Too Few Found

LOWFS_PY || O tiles 0 tiles

Al 0 tiles 0 tiles

LOWFS_NY || O tiles 0 tiles

Please save the results.

Only for one tile backtracking had to be used to find a guide star. If you are happy with the results
you should confirm this window by pressing ‘OK’.

At this point, you also have the possibility to use the tile operations as explained in Sect. 6.3.
Maybe you want to delete one or more tiles before you save the final survey area definition.
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7.2 Case B: a tiling run close to the Galactic pole

The ‘eso_survey' is close to the Galactic pole. Therefore, the stellar density is not the highest.
Indeed, when searching for guide/aO stars by pressing the ‘Start / Resume’ button in the main
SADT window, the ‘Guide Star Acquisition” window often turns red. This indicates that no guide
and/or a0 star was found in the originally foreseen tile position. The pawprints are shifted by the
‘Backtrack Step’ (an adjustable parameter in the ‘Configure..." menu, see Sect. 4.1) and the search
is started again. This is repeated until enough guide/aO stars have been found.

The following figure shows two snapshots of the guide/aO star search where backtracking is needed
(red background, left) and backtracking was successful (pink background, right):
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Many rows are shifted with respect to the original tiling without the search for guide/aO stars (see
Sect. 6.2). Also the ‘Finished’ window confirms the difficult search for guide/aO stars:

I X Finished

Mumber of tiles in the survey areas(s). 94

Mumber of pawprints in the survey areas(s): 564

Number of times backtracking had to be used to find a guide star
after the pointing creation was started or resumed: 127

Mone or too few guide/a0 stars

Type Mone Found | Too Few Found

LOWFS_PY || O tiles 0 tiles

AG 0 tiles 0 tiles

LOWFS_NY || O tiles 0 tiles

Please save the results.

Instead of originally 81 tiles, now 94 tiles are needed to cover the ‘ESO’ survey. In total, 127 times
backtracking had to be used to find an appropriate guide or aO star.

There is not much one can do about this. Maybe you can try whether another star catalog gives
better results with less backtracking steps. Or, you just delete some tiles at the periphery of the
survey areas with the tile operations (see Sect. 6.3).

Always, before starting a new guide/aO star search with new parameters, press the ‘Reset’ button
and confirm that you really want to delete the previously created tiles/pawprints.
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8 Step 5: Saving, opening and other file options

You are nearly done! CONGRATULATIONS!

The only action left is to save your results and go on with the OB preparations using P2PP for
Surveys. The ‘File’ menu offers some options to save and re-open your results.

Save: Assuming that you are happy with the final tiling of your survey — including the search for
guide and aO stars — you now should save the results. Do so by selecting ‘Save As ..." in the ‘File’
menu:

Options Help

Open
Save As ... {
Create survey areas from tiles in XML file ... E
Convert Existing XML File To Gnuplot ... ;
MNetwork preferences...

i

Exit

The pop-up window ‘Save’ will appear. There you can give the XML file a new name (but it
must have the suffix *.xml") and can choose the directory in which it should be saved. Confirm by
pressing the ‘Save’ button on the lower right of that window.

Of course, you already can save any intermediate step before the final tiling in the course of your
SADT session.

Note that the saved file will not include any deleted tiles or excluded survey areas.

Open: Maybe some days later you want to revise the survey area or delete some unnecessary tiles.
Just press ‘Open’ in the ‘File’ menu and select the XML file in the pop-up browser window. In
case you already had loaded a survey area, you will first be asked whether you want to replace the
current survey area by a new one.

It is important to note that SADT as designed works at the survey area level. In particu-
lar if ‘Start/Resume’ is pressed SADT will operate on the survey areas defined, computing new
tiles/pawprints and ignoring any pawprints/guide/a0 stars it may already have.

So when ‘Start/Resume’ is pressed after a previously saved XML file has been read back in with
‘Open’ any changes made to the tiles that SADT originally generated will be lost. As soon as
‘Start/Resume’ is pressed SADT starts to generate a new set of tiles/pawprints overwriting in
memory those that were produced before!

For example, a user who kept the same survey area but generated a complex geometry with many
deleted tiles would find that SADT would recompute all the tile positions based on the survey area,
and the previous, carefully made changes would be undone.

Create survey areas from tiles in XML file: This task converts tiles within a survey area saved
in an XML file into multiple survey areas one for each tile. To do so select an (already saved) XML
file containing the survey areas and tiles that you wish to work on again in SADT. You will be
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prompted for the name of an output XML file. The resulting output file will define each individual
tile as its own survey area containing a single geodetic rectangle, thereby protecting each tile from
being changed by SADT's tiling algorithms. For each survey area tileOverlapX and tileOverlapY
will be set to zero, but the original tile overlaps will remain preserved in the positions of the geodetic

rectangle survey area/tiles. You can then work with the converted file as with any other VISTA
SADT XML file.

This option might be useful for users that want to save their tile positions fixed within their survey
areas, so that the area is not retiled (and the user's work adjusting it undone) when SADT is next
asked to tile the survey (e.g. to find guide/aO stars for a complex set of tiles).

Convert Existing XML file to Gnuplot ...: This option is no longer supported. Please ignore
it. It will disappear in the next SADT version.

Network Preferences..: Specify a proxy server if required (e.g. in connection with a firewall).

Exit: Exit the SADT program. It is important to note that the parameters set in the menus are
not stored within SADT between invocations of it. Be sure to save your work as an XML file or
note your settings.
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A XML files

Viewing XML files:

After tile and guide/aO star generation VISTAs XML files can become very long. To view them it
is recommended that you use a viewer/editor that recognises XML structures and allows them to
be collapsed to a shorter more readable form, e.g. a web browser such as Firefox.

XML schema:

The XML schema is included as cfg/vista/sad.xsd in the directory sadtdirectoryname/cfg/vista.
The schema must be recognized by P2PP when it imports XML files made in SADT.

Users must not edit this file!

Structure of SADT XML files:
The XML file is structured as follows for a VISTA survey:

<SURVEY> element
which contains one or more
<SURVEY_AREA> elements
which contain one or more
<TILE> elements
which each contains (typically 6)
<PAWPRINT> elements
which each contains
<REFSTARS> elements
giving coordinates and magnitudes of the guide and aO stars
which are converted into .paf files attached to the OB
</REFSTARS>
< /PAWPRINT >
</TILE>
</SURVEY_AREA>
</SURVEY >

In the following four subsections we give examples for different aspects of the XML files created
by our ‘vista_survey' (Case A, see Sect. 5.1).
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A.1 Example: Survey areas (no tiles yet)

As an example the XML file saved for the survey areas of the vista_survey (see Sect. 5.1) after
pressing the ‘View/Update' button is as follows (using Firefox as a viewer):

This XML file does not appear to have any style information associated with it. The document tree is shown below.

— <SURVEY backtrackStep="100.0" id="examp_appl" ip="VIRCAM-142.96" maxJitter="15.0" tileAngle="0"

tileOverlapX="60.0" tileOverlapY="60.0">
<SURVEY_AREA coordSys="Galactic" exclode="false" lat1="-2.0" lat2="2.0" long1="30.0" long2="35.0"
number="1" posangle="0.0000" type="Coordinate Range"/>
<SURVEY_AREA coordSys="FK35 (J2000)" exclude="false" lat1="-02:00:00" lat2="+02:00.00"
longl="19:10:00" long2="19:30:00" number="2" posangle="0.0000" type="Coordinate Range"/>
<SURVEY_AREA coordSys="FK35 (J72000)" exclude="false" height="4.0" lat="-07:00:00" long="19:20:00"
number="3" posangle="-20.0000" type="Geodesic Rectangle" width="5.0"/>
<SURVEY_AREA coordSys="Galactic" exclude="false" lat="-2.5" long="26.0" number="4"
posangle="0.0000" radins="4.5" type="Circle"/>

</SURVEY>

w

Witin each defined type < /> parameters set are written in alphabetical order. The meaning of
these should be clear from earlier section of this Cookbook except for:

<SURVEY_AREA number="" — an integer ID counter for each survey area.
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A.2 Example: survey areas (with tiles but without guide/aO stars)

As a more complex example the XML file saved for the tiles defined in Sect. 6.1 (Case A) is as
follows, with guide/aO star finding switched off and everything under the tile elements and the
three last survey areas collapsed (using Firefox at the viewer):

This XML file does not appear to have any style information associated with it. The document tree is shown below.

- <SURVEY backtrackStep="100.0" id="examp_app2" ip="VIRCAM-142.96" maxJitter="15.0" tileAngle="0"
tileOverlapX="60.0" tileOverlapY="60.0">
— <SURVEY_AREA coordSys="Galactic" exclude="false" latl="-2.0" lat2="2.0" longl="30.0" long2="35.0"
number="1" posangle="0.0000" type="Coordinate Range">
+ <TILE dec="-023527.240" id="1_1" offangle="62.9041" priority="0" ra="185225.296"></TILE>
+ <TILE dec="-011733.360" id="1_2" offangle="62.8910" priority="0" ra="185504.848"></TILE>
+ <TILE dec="000019.800" id="1_3" offangle="62.8629" priority="0" ra="185744.424"></TILE>
+ <TILE dec="011811.160" id="1_4" offangle="62.8196" priority="0" ra="190024.192"></TILE>
+ <TILE dec="-020535.520" id="2_1" offangle="62.8644" priority="0" ra="184831.752"></TILE>
+ <TILE dec="-004742 360" id="2_2" offangle="62.8733" priority="0" ra="185111.448"></TILE>
+ <TILE dec="003011.160" id="2_3" offangle="62.8672" priority="0" ra="185351.072"></TILE>
+ <TILE dec="014803.960" id="2_4" offangle="62.8459" priority="0" ra="185630.816"></TILE>
+ <TILE dec="-013541.280" id="3_1" offangle="62.8330" priority="0" ra="184438 400"></TILE>
+ <TILE dec="-001748.120" id="3_2" offangle="62.8640" priority="0" ra="184718.192"></TILE>
+ <TILE dec="010006.120" id="3_3" offangle="62.8799" priority="0" ra="184957.840"></TILE>
+ <TILE dec="021800.720" id="3_4" offangle="62.8808" priority="0" ra="185237.512"></TILE>
+ <TILE dec="-010544.520" id="4_1" offangle="62.8102" priority="0" ra="184045.192"></TILE>
+ <TILE dec="001209.000" id="4_2" offangle="62.8632" priority="0" ra="184325.056"></TILE>
+ <TILE dec="013004.320" id="4_3" offangle="62.9011" priority="0" ra="184604.680"></TILE>
+ <TILE dec="024800.720" id="4_4" offangle="62.9240" priority="0" ra="184844 256"></TILE>
</SURVEY_AREA>
+ <SURVEY_AREA coordSys="FK35 (J2000)" exclude="false" lat1="-02:00:00" lat2="+02:00:00"
longl="19:10:00" long2="19:30:00" number="2" posangle="0.0000" type="Coordinate Range">
</SURVEY_AREA>
+ <SURVEY_AREA coordSys="FK35 (J2000)" exclude="fals¢" height="4.0" lat="-07:00:00" long="19:20:00"
number="3" posangle="-20.0000" type="Geodesic Rectangle" width="5.0"></SURVEY_AREA>
+ <SURVEY_AREA coordSys="Galactic" exclude="false" lat="-2.5" long="26.0" number="4"
posangle="0.0000" radius="4.5" type="Circle"></SURVEY_AREA>
</SURVEY>

wlene, 4

Within the <Tile /> element the ‘id" is constructed as TileRowNumber_TileColumnNumber where
the rows and columns start at 1,1 in the bottom right hand corner of each survey area.

Note that the ‘offangle’ is NOT the position angle input into P2PP (as discussed in Sect. 5).
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A.3 Example: Pawprint

The same ouput file as in the subsection before is next displayed showing the expanded first pawprint
of the first tile (using Firefox as a viewer):

This XML file does not appear to have any style information associated with it. The document tree is shown below.

— <SURVEY backtrackStep="100.0" id="examp_app2" ip="VIRCAM-142.96" maxJitter="15.0" tileAngle="0"
tileOverlapX="60.0" tileOverlapY="60.0">
- <SURVEY_AREA coordSys="Galactic" exclude="false" lat1="-2.0" lat2="2.0" longl="30.0" long2="35.0"
number="1" posangle="0.0000" type="Coordinatc Range">
— <TILE dec="-023527.240" id="1_1" offangle="62.9041" priority="0" ra="185225.296">
<PATTERN>Tile6n</PATTERN>
— <PAWPRINT dec="-024251.120" id="1_1:1" offangle="62.9083" offsetx="-0.475" offsety="-0.475"
ra="185234.848">
+ <REFSTARS></REFSTARS>
</PAWPRINT>
+ <PAWPRINT dec="-024020.640" id="1_1:2" offangle="62.9044" offsetx="-0.475" offsety="0.0"
ra="185215.264"></PAWPRINT>
+ <PAWPRINT dec="-023750.520" id="1_1:3" offangle="62.9007" offsetx="-0.475" offsety="0.475"
ra="185155.680"></PAWPRINT>
+ <PAWPRINT dec="-022803.360" id="1_1:4" offangle="62.9002" offsetx="0.475" offsety="0.475"
ra="185215.720"></PAWPRINT:>
+ <PAWPRINT dec="-023033.840" id="1_1:5" offangle="62.9037" offsetx="0.475" offsety="0.0"
ra="185235.304"></PAWPRINT>
+ <PAWPRINT dec="-023303.960" id="1_1:6" offangle="62.9073" offsetx="0.475" offsety="-0.475"
ra="185254.888"></PAWPRINT>>
</TILE> v
+ <TILE dec="-011733.360" id="1_2" offangle="62.8910" priority="0" ra="185504.848"></TILE>
+ <TILE dec="000019.800" id="1_3" offangle="62.8629" priority="0" ra="185744 424"></TILE>
+ <TILE dec="011811.160" id="1_4" offangle="62.8196" priority="0" ra="190024.192"></TILE>
+ <TILE dec="-020535.520" id="2_1" offangle="62.8644" priority="0" ra="184831.752"></TILE>
+ <TILE dec="-004742.360" id="2_2" offangle="62.8733" priority="0" ra="185111.448"></TILE>
+ <TILE dec="003011.160" id="2_3" offangle="62.8672" priority="0" ra="185351.072"></TILE>
+ <TILE dec="014803.960" id="2_4" offangle="62.8459" priority="0" ra="185630.816"></TILE>
+ <TILE dec="-013541.280" id="3_1" offangle="62.8330" priority="0" ra="184438 400"></TILE>
+ <TILE dec="-001748.120" id="3_2" offangle="62.8640" priority="0" ra="184718.192"></TILE>
+ <TILE dec="010006.120" id="3_3" offangle="62.8799" priority="0" ra="184957.840"></TILE>
i ul " inri ="]1R5737 317"/ TIL.E> b

I

Within the <Pawprint /> element the ‘id’ is constructed as Tile_ID:PawprintNumber.
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A.4 Example: Refstars

The <Refstars /> element of the first pawprint of the first tile from the same ouput file as in the
examples before is shown below expanded fully (again using Firefox as a viewer):

This XML file does not appear to have any style information associated with it. The document tree is shown below.

- <SURVEY backirackStep="100.0" id="examp_app2" ip="VIRCAM-142 96" max]Jitter="15.0" tileAngle="0"
tileOverlapX="60.0" tileOverlapY="60.0">
- <SURVEY_AREA coordSys="Galactic" exclude="false" lat1="-2.0" lat2="2.0" longl="30.0" long2="35.0"
number="1" posangle="0.0000" type="Coordinatc Range">
— <TILE dec="-023527.240" id="1_1" offangle="62.9041" priority="0" ra="185225.296">
<PATTERN>Tile6n</PATTERN>
— <PAWPRINT dec="-024251.120" id="1_1:1" offangle="62.9083" offsetx="-0.475" offsety="-0.475"
ra="185234.848">
— <REFSTARS>
PAFHDR.START ; # Start of PAF Header PAF.TYPE "paramfile”; # Type of PAF PAFID
"examp_app2-1-1_1-1-20090924001656"; # Unigue ID for PAF PAFNAME
"examp_app2-1-1_1-1.paf"; # Name of PAF PAF.DESC "Telescope guide star candidates for Pawprint
1"; # Short description of PAF PAF.CRTE NAME "SADT v3.04 (VIRCAM-142.96)"; # Name of
creator PAF.CRTE.DAYTIM "2009-09-24 00:16"; # Civil Time for creation PAFLCHG NAME
"SADT v3.04"; # Name of person/application changing PAFLCHG.DAYTIM "2009-09-24 00:16"; # ~
Timestamp of last change PAF.CHCK NAME ""; # Name of application checking PAFHDR.END ; #
End of PAF Header TPL.FILE DIRNAME "$INS_ROOT/SINS_USER/MISC/VISTA";
OCS.SADT.CAT.ID "GSC-2 at ESQ"; # Guide/AO star candidate catalogue OCS.SADT.IPID "SADT
v3.04, VIRCAM-142.96"; # Creator version TEL.AG.START "T"; # Start autoguiding
TEL.AG.GUIDESTAR "SETUPFILE"; # Select guide stars from this setup file (the default)
TEL.AO.START "T"; # Start active optics TEL.AO.AOSTARA "SETUPFILE"; # Select LOWFS_PY
stars from this setup file (the default) TEL.AO.AOSTARB "SETUPFILE"; # Select LOWFS_NY stars
from this setup file (the default)
</REFSTARS>
</PAWFPRINT>>
+ <PAWPRINT dec="-024020.640" id="1_1:2" offangle="62.9044" offsetx="-0.475" offsety="0.0"
ra="185215.264"><PAWPRINT>
+ <PAWPRINT dec="-023750.520" id="1_1:3" offangle="62.9007" offsetx="-0.475" offsety="0.475"
ra="185155.680"></PAWPRINT>
+ <PAWPRINT dec="-022803.360" id="1_1:4" offangle="62.9002" offsetx="0.475" offsety="0.475"
ra="185215.720"></PAWPRINT=>

<

="[] 4 renty="00"

Here the unique ‘ID" is derived by adding the date and time to the parameter file (paf) name. The
name consists of SurveylD(examp_app2)-SurveyAreaNumber(1)-TileID(1-1)-PawprintID.
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B Plotting tiles/pawprints in Aladin

Aladin (http://aladin.u-strasbg.fr/) is an interactive software sky atlas allowing the user to visualize
digitized astronomical images, superimpose entries from astronomical catalogs or databases, and
interactively access related data and information from the Simbad database, the VizieR service and
other archives for all known sources in the field.

SADT can export tiles for plotting in Aladin. SADT does this using a PLASTIC manager. PLAS-
TIC, the PLatform for AStronomical Tool InterConnection (http://plastic.sourceforge.net/), is a
VO protocol for communication between client-side astronomy applications.

Once you have created tiles, you should be able to send them to Aladin from SADT's PLASTIC
dialog. Note thate Aladin should be started, with Plastic hub manager, (on the same machine as
the SADT) before you attempt to export any tiles to Aladin.

Aladin V4 and V5 launched a PLASTIC manager by default, Aladin V6 will by default launch
a SAMP internal hub and not a PLASTIC internal hub. To launch PLASTIC internal hub you
have to specify in advance the “-plastic” parameter on the Aladin command line (http://aladin.u-
strasbg.fr/java/FAQ.htx#ToC34).

The ‘Plastic’ button in the SADT GUI brings up a Plastic dialog:

8O0 Plastic

HUB up [ Aladin |:]

Send Survey Area |f Send Survey Tiles “1 { Cancel 2?,

From this dialog it is currently only possible to send survey tiles (not survey areas) to Aladin. All
the pawprints are sent over and you should see their centres in Aladin. If other PLASTIC managers
are running in addition to Aladin the tiles can be exported to these by choosing between Aladin and
the other tools using the selection button at the upper middle right of the above ‘Plastic’ window.

Here we show how displays the pawprint centres of the 'ESO’ survey as rhombs:
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If you want to see the outlines of the pawprints rather than just their centres, you have to click
the right mouse button over the PLASTIC plane on the right hand side of Aladin and open the
‘Properties’ window of the plane with the pawprints:

800 Properties
Properties of the plane "PLASTIC"
PlanelD: | PLASTIC |
OO

Color:
| BRIl )] ]
Default shape: small circle B‘

Source: 564
Origin: plastic:/ fuk.ac.starlink.plastic.RmiAgent/35135a-3-VISTA_Survey_Area_Definition_Tool_Plastic_Manager

See catalog info

Used projection
.projection center 01 56 26.00 -29 28 04.0
.method [ ZENITAL_EQUAL_AREA [ ]

Associated FoVs

C Show all associated FoVs )

( Hide all associated FoVs )

Clicking on ‘Show all associated FoVs' should now show the outline of the boundary of each tile
(but not the individual detectors):

868 Aladin v5.0
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It also is possible to overlay the tiles onto an image of the field loaded into Aladin.

Disclaimer: ESO is not supporting the PLASTIC interface actively. If the export of SADT XML
files to Aladin or other VO tools fails due to the further development of those tools, ESO is not
responsible for finding a solution for the user. In the future, ESO might develop another ESO-
internal tool to view the defined tiles and survey areas on a sky map.
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C Help menu and configuration files

Clicking on the ‘Help’ menu in the SADT GUI brings up the following window:

8 relo

User Guide...
About...

5ta

e User Guide...: Refers the reader to the location of the external SADT User Manual from
the VISTA consortium. Note that future updates of the documentations will only be done

for the Cookbook.

e About...:

Gives the version numbers of SADT and Instrument Package version currently
being used, together with terms and conditions of use and a disclaimer.

Note that this

information gets obsolete in future versions of SADT, since it will be maintained by ESO.
For the Instrument Package version please follow the instructions on the SADT web page:

http://www.eso.org./sci/observing/phase2/VIRCAM/SADT .html

Cl1

Instrument package settings for SADT

The file default.isf in the VIRCAM Instrument Package contains, inter alia, some information that
SADT reads. Much of it is about the geometry of the IR detectors and CCDs and will not be

discussed here.

Another part deals with parameters that SADT reads, separately for each of the 2 autoguider and
2 wavefront sensor CCDs, which define how SADT will find the potential guide/aO stars in the
catalogs it is searching. The relevant values and their settings are:

Parameter Name Value | Description of value

NUMIN 1 | Minimum number of stars SADT should find

NUMAX 5 | Maximum number of stars SADT should find

SEPMIN 10.0 | Minimum separation (arcsec) from neighbouring stars whose
magnitude difference is less than MAGDELTA

MAGDELTA 2.5 | Smallest acceptable magnitude difference to neighbouring stars
within distance SEPMIN

MAXECC 0.3 | (for GSC-2 only) Maximum eccentricity allowed

MINPMER 5.0 | (for GSC-2 only) Minimum value of proper motion / proper
motion error ratio for which SADT applies proper motion
correction. If total proper motion is <MINPMER times its total
error then the guide star is not proper motion corrected by SADT.
Guide stars are not rejected based on their proper motion
regardless of whether or not the proper motion is corrected.

MINMAG (LOWES) 11.0 | Brightest acceptable aO star for this chip

MINMAG (AG) 10.0 | Brightest acceptable guide star for this chip

MAXMAG (LOWEFS) | 16.0 | Faintest acceptable aO star for this chip

MAXMAG (AG) 16.3 | Faintest acceptable guide star for this chip

The user must not change any of those settings!
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C.2 Configuration Files

The directory sadtdirectoryname/cfg/vista contains the XML schema defining the format of the
XML files SADT writes for ingestion by P2PP. The same directory contains two configuration files
in which various configuration parameters are set:

sadt.cfg: Configures most defaults in SADT. An explanation of all these properties is provided in
the sadt.cfg file itself.

skycat.cfg: The guide/aO stars are searched for in a selected catalog over the internet, and
skycat.cfg sets up the available catalogs appear in the catalog choice box of the SADT.

The guide/aO CCDs have | band filters so guide/a0 stars should ideally chosen by their magnitude
in | band. Not all of the catalogs accessible via skycat.cfg are suitable in some cases as guide/aO
star catalogs (e.g. 2MASS). One should select a suitable catalog for the guide/aO stars of a certain
survey area. The current recommended catalog is ‘GSC2- at ESO'.

The list of catalogs available in SADT was based on the entries of serv_type: catalog contained in
the standard skycat.cfg in Dec 2003. In principle SADT can also read other catalogs that can be
read by tools such as GAIA and JSkyCat. Adding a new catalog can be done as follows:

e Create/copy/edit a skycat.cfg file such as this distribution’s.
e Put all the catalogs you want to use into the skycat.cfg file.

e Edit the entry jsky.catalog.skycat.config=../cfg/skycat.cfg in the sadt.cfg file of this SADT
distribution so that the value of jsky.catalog.skycat.config is the path of the skycat.cfg you
want to use.

e GAIA/SkyCat/JSky catalogs can be online as well as in a local file conforming with the
GAIA (http://star-www.dur.ac.uk/ pdraper/gaia/gaia.html ) /

SkyCat (http://archive.eso.org/cms/tools-documentation/skycat ) /
JSky (http://archive.eso.org/cms/tools-documentation/jsky/ )
catalog conventions.

Note that the use of local GAIA/SkyCat/JSky catalogs has not been tested.
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